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Introduction

The Content Author’'s Cookbook is designed to give content authors the information they
need so that they can use Sitecore CMS to perform their day to day work. This cookbook
is primarily aimed at introducing new content authors with limited computer skills to the
tools that Sitecore contains. However, the procedures described in this document will
also be beneficial for more experienced and technically skilled content authors who are
unfamiliar with the tools that Sitecore contains.

Content authors must be able to update existing content on their corporate Web site or
intranet as well as create new material. This cookbook explains how to perform both
these tasks with the two editing tools that Sitecore contains — the Page Editor and the
Content Editor — and demonstrates how to edit existing items and create new items with
both of these tools. The cookbook also introduces some of the more advanced features
and functionality that Sitecore contains.

This Content Author’'s Cookbook contains the following chapters:

e Chapter 1 — Introduction
This chapter is a description of the content, aims and the intended audience of this
manual.

e Chapter 3 — Sitecore
An introduction to some basic Sitecore functionality including item locking and formatting.

e Chapter 4 — Managing Content in the Page Editor
Step by step instructions for using the Page Editor to create and edit content.

e Chapter 5— Managing Content in the Content Editor
Step by step instructions for using the Content Editor to create and edit content.

e Chapter 6 — The Rich Text Editor
Step by step instructions for creating several versions of the same item as well as
creating different language versions of the same item.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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Chapter 7 — Workflows for Content

Editors

This chapter describes workflows, what you can use them for, and how Sitecore uses
them. There is also a description of the Workbox.

e  Workflows

e The Workbox

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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2.1 Workflows

Workflows are a system that you can use in Sitecore to control when an item is published.

A workflow is a series of states that you define to reflect the work processes and procedures that you
employ in your organization for creating Web content. These states can correspond to the creation,
review, and approval stages that items must go through before they are published on your Web site.

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only
items that have been approved are published.

A workflow can contain any number of different workflow states and be as simple or complex as required.
Items do not necessarily have to pass through all the workflow states that you have defined — some
states can be optional or only applicable for certain kinds of content.

Furthermore, you can implement any number of different workflows. Each workflow must contain one
workflow state that has been defined as the final workflow state.

Items must pass through the appropriate workflow states and can only be published when they are in the
final workflow state.

2.1.1 Implementing Workflows

Workflows are normally implemented by developers. It can however be useful for content authors to
understand how they are constructed and implemented.

Workflows consist of special items that are stored in the Sitecore content tree.
A workflow consists of:
A Workflow — the main item that contains all of the subitems that make up the workflow.

Workflow States — the basic building blocks of the workflow. The workflow states represent the different
stages in your content creation process. Items that are sent through a workflow start in the initial workflow
state and in the final workflow state.

Workflow Commands — the actions that must be performed by the various contributors to move the
items from one workflow state to another.

Workflow Actions — actions that are automatically performed on the items when they are in particular
workflow states or when particular workflow commands are executed.

Here is an example of a workflow:

+

Workflow Items I
= & Workflows

T Workflow =t = T Sample Workflow , Workflow States

= [ editng <«——— Initial Workflow State

&) Submit

&) Command = [@ Reviewing
. !a Approve

&8 Action O Reject

= @ Publshed «———Final Workflow State

@ Auto Publish ~

(L) State

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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After the workflow has been defined, the developer specifies which item templates are subject to the
workflow. When they have done this, every time a content author creates or edits an item that is based on
one of these templates it is sent to the initial workflow state of this workflow.

Important
Items can only be published when they are in the final workflow state.

2.1.2 Using Workflows

After the workflow has been implemented, content authors must send the items they create or edit
through the workflow before they can be published.

When you create a new item it is automatically placed in the initial workflow state. The item remains in
this state until you use a workflow command to move it to another workflow state.

If you edit an existing item that is subject to a workflow, Sitecore creates a new version of this item and
places it in the initial workflow state. If you edit this item again later, you edit the version that is in the
workflow unless you specifically that you want to edit another version.

Important
Items that are edited by administrators are not subject to workflows.

Sending Items through Workflows
When you have finished editing the item, you can send it to the next workflow state.
To send an item to the next workflow state:

1. Inthe Content Editor, open the item that you are working on.

2. When you are satisfied that it can be send on through the workflow, click the Review tab.

o Home Navigate Review Publish Versions My Toolbar

You have locked this item, | %® CheckIn (&) Submit . @
RN 3
speling Markup Validation || My Items 4P History Reminder ~  Archive +
t oofing Locks Wo Sched

| Q | acament\ B2 ]_

= & Content - Ala
8 G Home m Qur-Company

) standard Ttems

/&y If you publish now, the selected version will not be visible on the Web site because it is not in the

1@ Froducts final workflow step.
3 Services Version 1 wil be published instead.
‘@ References <f Banner a8
G New:
B @ News Banner Slogan:
] ] People Great Company!
| &3 Our-Company Great Products!

As you can see, the Workflow group displays a workflow command — Submit. This is the only
workflow command that you can apply to the current item in its present workflow state.

Furthermore, the item also displays a message informing you that this version of the item cannot
be published because it is not in the final workflow state.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.
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@ sitecore

Click Submit to send the item to the next workflow state. Sitecore displays a dialog box for you to

enter a comment

A sitecore -- Webpage Dialog

Enter a comment:

4. Enter a comment and then the item is moved to the next workflow state and the workflow
commands that are available in the Workflow group change to reflect the items new status.

Publish

Versions My Toolbar

Locks

‘ Click Edit to lock and edit this item,

[ Edit

Q Approve

§r History o Reject

]

= & Content
= ) Home
i) Standard-Ttems
@ Products
3 services
‘@ References
& News
LII Peaple
&3 Our-Company
) Metz-Data
) settings

' Content W

m Qur-Company

‘3 You must lock this item before you can edit it.

To lock this item, click Edit on the Home tab.
® Lock and Edit

& If you publish now, the selected version will not be visible on the Web site because it is not in the

final workflow step.
Version 1 will be published instead.

J Banner

Banner Slogan:

However, if you do not have permission to edit the item in this workflow state, you cannot lock the

item for editing and the workflow commands will not be displayed.

Sitecore also contains a Workbox that been designed for give reviewers a greater overview of all the

items that are

in workflows.
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2.2 The Workbox

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform
their tasks.

Using the Workbox

When you need to review content items, you should use the Workbox to see all the items that are
currently in workflows and which workflow states they are in.

To use the Workbox:
1. Log in to the Sitecore Desktop.
1. Click Sitecore, Workbox:

% Workbox

Sample Workflow

f Draft - (none)

l Awaiting Approval - (1 item)

Da Our-Company - [English, version 2}

hange: audrey changed from Draft to Awaiting Approval on 1. apri 2003, More »

B prrevien [@open oiff @ approve @ Reject

| @ Aporove (selected) @ Anprove () EDReject (selected) € Reject ()

In the Workbox, you can see that the Sample Workflow has been selected and you can see all
the relevant workflow states. You can also see that there is one item in the Awaiting Approval
workflow state.

2. Inthe every workflow state, you can preview, open, compare, each item as well as apply the
workflow commands that have been defined for that workflow state. In the Awaiting Approval
workflow state, you can approve, or reject the item.

Previewing an Iltem

To preview the version of an item that is in a workflow state, click Preview and this version of the item is
displayed in a new browser window.

Opening an Item

To open an item, click Open and the item is opened in the Content Editor.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.
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Comparing an Item

To see the changes that have been made to an item, click Diff.

2 Sitecore — Webpage Dialog
1oy Compare Versions
u Compare two version of the same item. The differences are highlighted.

One Column Two Columns.

E v

Qur Company

ooltip:

! page Title and Text =

Qur Company

Text:

What a company this is to work in! # We are an innovative
company that offers a unique range of products and services.

| Related Ttems @
Related Items:
| sidebar @

The Compare Versions dialog box lets you see the changes that have been made to this version of the
item. You can select which versions to compare and whether you want them displayed in one or two

columns

Approving or Rejecting an Item

When you are finished reviewing the item, click approve or reject to move the item to the appropriate

workflow state.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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Several Workflows

If you have implemented more than one workflow, you can view them at the same time or switch between
the different workflows in the Workbox.

% Reqular review
[} Edit- mone)

[a Awaiting Approval - (none)

% Validation

(&} Edit- 1 item)

Awaiting Approval - (1 item)

O ﬂ Corporate info - (Enghsn, verson 2)
minnie changed from Edit s Awaiting Approwalsn Thureday, July 03, 2008, Mare «

Brreven Booe Dot Daooe Qreea

| @ approe (seiected) @ Acprove (a1) @ Reect fseiected) @ Reject (ol)

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows group.
You can also expand and collapse each workflow and workflow state.

[ ]
Customizing the Interface
Step by step instructions for publishing content on your Web site.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.
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Sitecore

This chapter introduces some of the basic Sitecore functionality. This chapter explains
how to log in, how item locking works, and describes how roles affect the functionality
that is available to you in Sitecore CMS.
This chapter contains the following section:

e Logging In

¢ Roles and Functionality

e Item Locking

e Formatting

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.
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3.1 Logging In
You must log in to Sitecore before you can edit any of the content on a Web site.
To log in to Sitecore:

3. Enter Sitecore after the name of your Web site, for example

http://www.mywebsite.net/sitecore and the Log in page appears:

a

Q sitecore’

Welcome to Sitecore

User name: |minnie

Password:

Forgot Your Password?  Change Password

Browser Notes

What do you want to do

You are using Internet Explorer 7.

Please choose an activity... Sitecore supports all user interfaces for this
browser.

G w4l v |8 et ffarm myserver..f

W | @siecore

Edit Web Site Use Content Editor

Advanced Options...

Visit www.sitecore.net

4. Select the task you want to perform, enter your user name and password and click Log in to log in

and start editing the Web site.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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Alternatively, click Advanced to open the Advanced Log In window.

Q sitecore’

Login Advanced

Welcome to Sitecore

User name: |minnie

Password: |e

Forgot Your Password? ~ Change Password

Browser Notes

Select User Interface

You are using Internet Explorer 7.

Sitecore supports all user interfaces for this

El Desktop w Content Editor browser.
@ Page Editor E Preview

-
‘) Workbox g Developer Center

Browser Display Mode: | Normal M

Client Language: | Default

5. Select the User Interface that you want to use, enter your user name and password, and click

Log in to log in and start editing the Web site.

Note
In this manual, we use the Sitecore Training Sample Site as our demonstration site.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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3.2 Roles and Functionality

Sitecore contains tools that are suited to both experienced and inexperienced content authors. The
Content Editor is the editing tool for experienced users. However, depending on the roles you have been
assigned, the functionality that is available to you may differ from the functionality described in this guide.

For example, a user who has been assigned one set of roles may see the following ribbon in the Content
Editor:

83 About Us Section

3] Contact Section

Whereas a user who has been assigned another set of roles may see much more functionality in the
Content Editor ribbon:

Mavigate  Review  Publish

&3 About Us Section

23] Contact Section

Furthermore, when you log in to the Sitecore Desktop, the set of applications shown in the Sitecore menu
also depends on the roles that have been assigned to you. The following images show the Sitecore menu
for two users who have been assigned a different set of roles:

Web Site Developer

sitecore bill

Content Editor Page Editor
Manage your content. =
==| Media Library

Boll| Maintain media content. ﬁ Debug

Lonnie L

sitecoreljonnie

a Content Editor @ Page Editor

Manage your content.

o & Developer Center |
review y ity. * Carousel
(5| Medi Library Create new functionality. :
el i * aain Template Manager g] Recyde Bin
Create new templates,
gj Recyde Bin G Search
% Search @ Waorkbox
T Workbox Control Panel
ControlPanel @ | __: Development Tools »

All Applications [ All Applications [}

@Repomngﬁuls @RapurﬁngTuols

§\ LogOff i\ Logoff

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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3.3 Item Locking

Sitecore uses item locking to ensure that two different users can’t edit the same item at the same time. If
two or more users somehow managed to edit the same item simultaneously only the changes that have
been made by the user who pressed Save last will be available. All the other changes will be lost.

Item locking is a system whereby you lock the item you are editing and prevent other users from editing
this item until you unlock it again after you have finished editing the item.

Item locking works differently depending on the tools that you are using.
e Inthe Page Editor, you can lock an item before you start to edit it.

¢ Inthe Content Editor, you must lock an item before you can edit it.

3.3.1 Item Locking in the Page Editor

In the Page Editor, the way that item locking works depends on the access rights that you have been
assigned.

Minimal Page Editor

If you only have access to the Minimal Page Editor, you do not have access to the ribbon and cannot
manually lock an item before you edit it.

In this case, Sitecore checks whether an item is locked or not when you save it. If the item is not locked
your changes are saved. If the item has already been locked by another user, you receive a message
informing you that the item has been locked by another user and your changes cannot be implemented.

Limited or Full Page Editor

If you have access to the Limited Page Editor or the Full Page Editor, you can edit an item directly on the
page without locking it. When you save the item, Sitecore locks it for you. If the item has already been
locked by another user, you receive a message informing you that the item has been locked by another
user.

Alternatively, you can click Lock or Edit to manually lock the current item before editing it.

Save Save & Close Close Ribbon

W8

Page Editor | Preview || Insert Delete Lock My Ttems (3) Werkbox: || Log OFF

» Home » People ¢ | S Go (B Edit

When an item has been locked by you, it is noted in the My Items command.

Save Save & Close Close Ribbon

E R TRERE

Page Editor | Preview || Insert Delete | Lock | My Items (2) | Workbox || Log Off

» Home b People b | & Go (B Edit

In the previous image, the user has locked two items.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 16 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

When you have finished editing the item, you must remember to unlock it so that other users can edit it if
they need to.

Unlocking Items

You must remember to unlock items that you have locked.

To unlock an item, select the item and click Edit or Lock

If you have locked and edited humerous items, you can easily lose track of them all.

To see which items are still locked by you, in the Edit group, click My Items:

2 Sitecore -- Webpage Dialog, @

m My Items
Views the items that are locked by you.

MName Path
Home fsitecore/content/Home
Middle-Teaser fsitecore /content/Home fStandard-Items,TeasersMiddle-Teaser

Page 1 of 1 (2items)

Y [ unlock Al

Close

The My Items dialog box lists all of the items that you have locked.

To unlock one or more items select them and click Unlock. To unlock all the items, click Unlock All.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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3.4 Formatting

In Sitecore, the formatting of the content that is displayed on a Web site is generally controlled by the
style sheets that have been defined for the Web site by the administrators, designers, programmers, and
so on.

This means that as a content author you do not have to worry about how the material you are responsible
for is presented to the reader and can concentrate on the quality of the material.

You can of course influence the style by making some text bold or italic and so on. Furthermore if you
know how to write HTML you can edit the code and thereby influence the way that the content is
presented. But in general you can concentrate on the material that is presented and ignore the way that it
is formatted.
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Managing Content in the Page Editor

This chapter introduces the Page Editor and the functionality it contains. It contains
detailed descriptions of how to edit an existing item including how to edit simple text fields
and rich text fields. There is a description of how to manage images in the Page Editor.
There are also detailed instructions on how to create new items.
This chapter contains the following sections:

e The Page Editor

e Editing an Item in the Page Editor

e Creating a New Item in the Page Editor

e Deleting Content
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4.1 The Page Editor

Content authors are generally focused on the quality and accuracy of the material displayed on the Web
site and not on the design, style, and layout of the site. For this reason most content authors prefer to
work in a program that is designed to meet their needs and not those of the developers and designers
who create the Web sites.

With this mind, Sitecore CMS allows content authors to edit and create items directly on the Web page
with the Page Editor. The Page Editor is the simplest of the editing tools that Sitecore contains. It is
designed for inexperienced content editors who edit and write content items directly on the page. Itis a
WYSIWYG editor (what you see is what you get) and limits the amount of functionality that is presented to
the user.

When you log in to the Page Editor, the functionality that is available to you can vary depending on the
security roles that you have been assigned and the customizations that have been carried out on Web
site you are accessing.

When you log in to the Page Editor, two buttons are displayed at the top of the Web page:

Edit Log Off

YourSite.net

You can then navigate to the page that you want to edit and click Edit to open the Page Editor in edit
mode.

The functionality that you have access to in the Page Editor can vary greatly. As a minimum you can
expect to see some buttons at the top of the Web page:

Save Save &Close Clase Insert Delete

F?_

YourSite.net

If you have been given more access rights, you might be able to use a ribbon of commands. The ribbon
you are presented with could look something like this:

Save Save & Close Close Ribbon

Page Editor | Preview || Insert Delete Lock My Items (0) Workbox || Log Off
Browser | | Ec Log O

» Home b | © Go [ Edit

This ribbon contains all the functionality available in the previous screenshot plus a little more.

When you are editing an item, you can click Ribbon to temporarily hide the ribbon and give yourself some
more space to work with or have a less confusing layout. Click Ribbon again to display the ribbon.
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If you have been given full access to the all the functionality contained in the Page Editor, you will be able
to use all the commands in this ribbon:

Save Save & Close Close Ribbon

Page Editor Home Publish Versions Presentation View

Page Editor | Preview Debug || Insert Delete Lock My Items (0) Workbox
Browser Views

» Home ¢ | &% Go [ Edit

Log Off
Log Off

This ribbon consists of six tabs each with its own collection of commands.
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4.2 Editing an Item in the Page Editor

As mentioned earlier, the Page Editor is the simplest of the editing tools that Sitecore contains and has
been designed for content editors who want to do their editing directly on the page.

The Page Editor is a WYSIWYG editor that allows you to see the changes that you make directly on the
page. This makes it easier for inexperienced users to control the changes that they make to the content
items they are responsible for.

In the Page Editor, you can edit:

e Simple text fields, date fields, and so on —fields that you must edit on the page and have no
extra functionality associated with them.

e Rich text fields — fields that you must edit in the Rich Text Editor.

e Media items — any kind of graphical item or sound file.

Note
In all of the procedures described in this manual, we use the Sitecore Training Sample Site as the
demonstration Web site.

4.2.1 Editing a Simple Text Field
To edit a simple text field:
1. Open the Starter Kit and log on to the Page Editor.
2.  When the Page Editor opens it displays two buttons:

Edit Log Off

YourSite.net '

Navigate to the item that you want to edit.
Click Edit to start editing the item.

In the item, select a simple text field that you want to edit.

Q Edit this site ‘@ Help site ¥ print "8 sitemap

Use this space to create a
slogan or eye catching
text.

6. Edit the text directly on the page. The text field automatically expands to fit the text you enter.
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7. When you are finished editing the text, you can start editing another text block or click Save to
save the changes, Save & Close to save the changes and exit editing mode, or Close to close the
item and exit editing mode without saving the changes.

4.2.2 Editing a Rich Text Field
A rich text field gives you more control over how the text appears on the Web page.
To edit a rich text field:

1. Select arich text field and Sitecore displays some extra options.

Depending on your installation, the options can vary from

Audrey a User with mormal Audrey a3 User with normal
authoring authoring
features. features.

Denny d  User with page Denny d  User with page
designing designing
features. features.
Admin b User with access to Admin b User with access to
all features. all features.
= Edit Text | cedtText B T U 0 (& |
[ R T N |

You can either edit the text directly on the page or in the Rich Text Editor.

2. When you edit a rich text field directly on the page, you can not only edit the text but may also be
able to format it. You make the text bold, italic and underlined.

You can also insert a link or an image into the item

Inserting a Link

To insert a link into a rich text field:

1. Click the link button <@ to open the Insert a Link dialog box.

& Sitecore -- Webpage Dialog, @

Insert a Link

= Select the item or media that you want to create a link to.

Internal Link | Media Items
= 'y Content}
& &3 Home
& @) sample
® @) Help
& ) Meta-Data
& ) settings

2. Inthe Insert a Link dialog box, expand the content tree and select the item that you want to
create a link to.

3. Click Link to create the link.
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4. |If the item that you want to link to is an image or media file, click the Media Items tab.

A sitecore - Webpage Dialog,
Insert a Link
Select the item or media that you want to create a link to.

| Internal Link | Media Ttems |
B &) Media Library
i Files

& ) images

Upload

5. Expand the content tree and select the media item that you want to link to.
6. Click Link to create the link.

Inserting an Image
To insert an image into the rich text field you are editing:
1. Click the Insert Image button &l o open the Insert Media Item dialog box.

A sitecore - Webpage Dialog,
= Insert Media Ttem
‘fou can insert a media item here.

i) Images .rlj

Name: ‘ ‘

l Upload ” Edit ] [ Insert ” Cancel ]

2. Expand the content tree and select the image or media item that you want to insert.

As you can see you can also insert other types of media into the item. These could be
animations, film clips, sound files, and so on.

3. Click Insert to insert the image into the rich text field.

Uploading an Image or File

If the media file, that you want to create a link to, is not available in the media library, you must upload it
to the media library.
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To upload an image or file to the media library:

1. Inthe Page Editor, click the Insert Image button &

A sitecore - Webpage Dialog,
= Insert Media Ttem
‘fou can insert a media item here.

i Files

i) Images a.’lj

Name: ‘ ‘

l Upload ” Edit ] [ Insert ” Cancel ]

2. Inthe Insert Media Item dialog box, click Upload to open the Upload a File dialog box:

2 Sitecore -- Webpage Dialog,

Upload a File
Select a file. When done dick the Upload button.

Filename:

Cancel

3. Inthe Upload a File dialog box, click Browse to locate the file you want to use. When you select
the file, it is automatically uploaded to the Sitecore Media Library.

When the media file is available in the Media Library, you can create a link to it or use it to illustrate your
Web site.

4.2.3 Editing a Rich Text Field in the Rich Text Editor

You can also edit rich text fields in the Rich text Editor.

1. Select the rich text field that you want to edit:

Audrey a User with normal
authoring
features.

Denny d User with page
designing
features.

Admin b User with access to
all features.

medtTet B J U D &
e e e s
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2. Click Edit Text to open the text in the Rich Text Editor:

A Sitecore -- Webpage Dialog,

%

20 s e

User

When you dlick the @ Edit this Site link, you are requested to enter 2 username and a password.
The starter kit includes seme predefined users that demenstrate various levels of functienality.

Choose one of the following:

Minnie | m User with minimal authoring features.

Pass Description

Lonnie | | User with limited authoring features.

Audrey: a User with normal authoring features.

Denny | d User with page designing features.

Admin | b User with access to all features.

@Daslgn :_]HTML Accept Reject
e

3. You can now edit the item in this window.

The Rich Text Editor gives you access to more functionality. You can:

Insert and delete links to other parts of the Web site and to external Web sites.
Insert pictures or other media items.

Insert symbols into the text

Paste text from Microsoft Word into the item.

If you prefer, you can use Microsoft Word to write the text you want to use in the item and
paste it into the Rich Text Editor.

Find and replace text in the item.

4. When you are finished editing the item in the Rich Text Editor, click Accept to save your changes.

Furthermore, you can also view the item in HTML format, if you have the necessary expertise and feel
comfortable editing the text in that format.

Note

The functionality that is available in the Rich Text Editor is controlled by your Sitecore system
administrator. If you need more functionality, ask your administrator to make it available to you.

For more information about using the Rich Text Editor, see Chapter 6 ‘The Rich Text Editor.’
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4.2.4  Editing a Graphical Item

You can also use the Page Editor to edit any graphic items that are displayed on the Web site. When you
select an image, you are presented with some additional options:

&

& Editlink [5&] Choose Image [&4] Properties

You can:
e Edit the link that the image contains — if there is one.
e Select the image to be displayed.

o Edit the properties of the image.
Once again, the options that are available to you can vary from installation to installation.
Editing the Link

To edit the link:
1. If the picture is a link, click Edit Link:

A sitecore - Webpage Dialog, @
Internal Link
= Select the item that you want to create a link to and spedify the appropriate
properties,
Link Description:
= '.ﬂsamp|g Anchor:
= ?’HEID Target Window: | Active browser ~
& ) Standard-Ttems .
|83 Authors
g Designers Style Class:
# i Developers e
® (J Meta-Data Alternate Text:
@ ) settings Query String:

2. Inthe left-hand pane of the Internal Link dialog box, select the item that the link should open.
You can only link to another item in this Web site and cannot link to another Web site.

3. The Internal Link dialog box contains the following fields:

Field Value
Link Description A description of the link.

Anchor The name of the anchor on the page you want to link to.
The browser will scroll directly to this point on the page.
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Field

Value

@ Sitecore

Target Window

Whether the link should use the same browser window,
another browser window or a custom window.

Custom If you select Custom in the target Window field, you specify
the custom window here.
Style Class The style class that you want to use.

Alternate Text

An alternative text that will be displayed when you move the

mouse over the image.

Query String

A query that will be added to the link.

4. Fill the fields in with the appropriate information.

Changing the Image

To change the image that is displayed in the rich text field:
1. Inthe Page Editor, select the image that you want to change.

2. Click Choose Image to open the Media Browser dialog box:

2 Sitecore -- Webpage Dialog, @

2 Media Browser
Bl | solect the image or file that you want to open.

= [&8] Media Library -~
=J,J Files
= ) Images
® J Banners
£ =J,J Categories
& ) Help Site
# iJ Logos
£ =J,J News
& J,J Peaple
& J Products
® ) References
= J,J Teasers
= Changelogo
4 confused
isii Developer ]
< bd

Name: |/Images/Teasers/confused

Upload

-4
g ]
confused

The Media Browser dialog box lets view all of the items that are currently available in the

Sitecore Media Library.

3. Select the image that you want to use and click OK.

This new image is inserted into the current item.

4. Inthe Page Editor, click Save to save the changes, Save & Close to save the changes and exit
edit mode, or Close to close the item and exit edit mode without saving the changes.

Editing the Properties of an Image

To edit the properties of the image:
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1. Click Image Properties to open the Image Properties dialog box.

3 sitecore - Webpage Dialog, E]
= Image Properties
Set the properties for the image here.
Text
Alternate Text: “

Default Alternate Text: Confused?

Dimensions

Enter the dimensions of the mage if they are different than the dimensions of
the original. This will only affect the reference and not the original image.

Original Dimensions: 800 x 400

Space

Please provide the desired space to place around the image.

2.

image.
3.

they differ from the actual size of the image.
4,

@ Sitecore

In the Alternate Text field, enter the text to be displayed when you move the mouse over the
In the Dimensions section, specify the dimensions that the image should be displayed in — if

In the Space section, specify how much space should be placed around the image.
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4.3 Creating a New Item in the Page Editor

As a content author, you not only have to edit content but also create new content items and insert them
into the Web page where you want them displayed.

The ways in which you can create items in Sitecore can vary depending on the security roles that you
have been assigned and the way your Web site has been customized.

4.3.1 Inserting Items

When you log on to the Page Editor, you should navigate to the page that you want to edit. When you
click the Edit button at the top of the page, you are presented with all of the editing tools that are available
to you on this Web site.

To insert a new item onto the page:

1. Click Insert to open the Insert dialog box.

2 Sitecore -- Webpage Dialog, @

5 Insert
Select the insert option you want to use, Click Insert to use the
option.

43 About Us Section

2] Contact Section

] Executive Profiles Section
(8 J0bs Section

& News Section

i@ Product Section

§ References Section

£} Services Section

i@ Site Section

Ttem Name: |

The type of item that you can create will vary depending on where you are on the Web site. If you
are on the front page, you can insert a new section and depending on the type of section you are
on, you can add appropriate items to that section.

2. Select the type of item that you want to insert. In this example, you insert a new section.
3. Inthe Iltem Name field, enter the name of the section that you want to insert.
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4. Click Insert to create the new section and a section is added to the Web site:

Save Save & Close Close Insert Delete
. EETTE— -
YourSite.net

o Edit this Site @ Help Site ‘x Print == Sitemap

[No text in field]

Products

Home »

Products Products sidebar title: [No text in field]

sidebar text: [No text in field]
Provide your main text here...

This page inherits sidebar text because the

fields above are blank for this page.

Provide text for the fieids sbove o averride
the interited sidebar for this page.

Change the text below to medify the
inherited sidebar text at its source.

Who am I?

Whan you click the @ Edit this site
link, you are requested to enter a

As you can see the new section contains no items and the sidebar contains the same text as the

Home page.

When you create a new item it is automatically locked to prevent other users from editing it.

5. To add an item to the Products section, click Insert and the Insert dialog box contains
following options:

72 sitecore -- Webpage Dialog
M Insert
H|  select the insert option you want to use. Click Insert to use the
option,
& Product Category

@ Product Description

Ttem Mame: || |

6. Select the item that you want to create.

7. Inthe ltem Name field, enter the name of the new item and click insert.

the
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These items have different designs and allow you to present different information on the Web
page.

[No text in field]

Praducts

Home »

Products Products sidebar title: [No text in field]

sidebar text: [No text in field]

Product Category Provide your main text here...

This page inherits sidebar text because the

Product Descripti
rodu; escription fields above are blank for chis page

. Product Category Aotk e he s o
-

overview abstract: [No text in field] the inkerited sidebar for this page.

Change the text below to madify the
inherited sidebar text at its source.

Product Description

? X Who am I?

. number: [No text in field]

price: [Wo text i Rekd] When you dlick the @ Edit this Site

overview abstract: [No text in field] link, you are requested to enter a
username and a password.

Both the items you can select and the presentation possibilities that they give you are determined
by the design and style that has been implemented on your particular Web site.

8. You should now edit the items and the section you have inserted and add text, images, sidebar
text, and so on.

When you are finished editing the new items, you must unlock them.
To unlock the items:
1. Inthe Edit group, click My Items to see a list of all the items you have locked.

2 sitecore -- Webpage Dialog,
My Items
Yiews the items that are locked by you,

Name
Developer Jeitecore content/Home,Jobs/Developer
Jobs [sitecore content/Home/Jobs

4 4 T » 1] Page 1of 1 (2items)
ot [
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2. Inthe My Items dialog box, select the items that you have finished editing and click Unlock to
unlock the item. If you have finished editing all the items, click Unlock All to unlock all the items.
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4.4 Deleting Content

Content authors must delete items and content from time to time. This is a very simple task in the
Sitecore Page Editor.

4.4.1 Deleting an Iltem
To delete an item from the Web site:
1. Navigate to the item that you want to delete.
If you want to delete an item, navigate to that item.

If you want to delete a sub-item, navigate to the sub-item in question and not just the link to it that
is shown on another item.

2. Click Delete to remove the item or section.

Once again depending on the customizations carried out on your Web site and the way the Page
Editor has been configured, the Delete button may be located on the ribbon or at the top of the
screen.

3. If you try to delete an item that contains sub-items, a message will appear informing you that that
the section contains sub-items and that these items will be deleted along with the section.

Windows Internet Explorer

2
2

Are you sure you want to delete "My Products"?

This item has sub-items which will also be deleted if wou delete this item.

If you want to save any of the items, you must move them to another section.

4. Click OK to delete the item and its subitems.
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Managing Content in the Content Editor

This chapter introduces the Content Editor and the functionality it contains. It contains

detailed descriptions of how to edit existing items. There is also a description of how to
manage images in the Content Editor. There are detailed instructions on how to create
new items and how to delete items.

This chapter contains the following sections:
e The Content Editor
e Editing an Item in the Content Editor
e Creating New Items in the Content Editor

e Deleting Items in the Content Editor
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51 The Content Editor

The Content Editor has been designed for more experienced content authors who feel comfortable
working with a computer, Microsoft Word, and are familiar with Sitecore and the functionality that it
contains.

The Content Editor is a large application but its appearance and the functionality that it contains varies
depending on the roles that have been assigned to the user, the local security settings and the amount of
customizations that have been carried out on your installation.

The Content Editor gives the user access to an array of functionality that meets the needs of the more
experienced content author.

The functionality that you have access to in the Content Editor can vary greatly. As a minimum you can
expect to see:

|3 contact Section {10f7) |ute x AU R Fist

3]i Executive Profiles Section {2 9 Down ' Last

If you have been given more extensive access rights, you will probably have access to more commands
and more tabs:

&3 About Us Section
2] Contact Section

5.1.1 The Page Editor vs. the Content Editor

When you log in to the Content Editor, the items that make up your Web site are presented to you in a
very different way that they are in the Page Editor. In the Page Editor, you see the items as they are
presented on the Web site. In the Content Editor, you see the items as objects in the content tree and
when you select an item it is presented to you as a list of fields that you can edit.
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For example, the Products section of the Sample Web site looks like this in the Page Editor:

save Save & Close [ mopon |

Insert Delete Lock MyItems (1) Workbox || Log OFf
wﬂ

| » Sample b Products b |  Go [F Edit

sItecore’ siecore e

compelling web experiences’ Q Edit this site ¥ Print 8 Sitemap

= - mmm- e | ot [ v |

w
- You want products?
We've got products!

Products Products Product Awards

e et If your organization sells products, ereate a Product Section ta showcase them. Weoie prais bt s e i
market.

Office Products This demonstration section shows how you can organize your products into Product
You know it and the exparts know it.

@ Vacation Products Categories.
In fact, your products have von

numerous avards.

Home Products But do your visitors know it?

Take a look at these time saving innovations for the home. L R

read more sidebar.

Office Products

Labor saving devices that save your organization money.

read more

You can edit all of the items that appear on the page — text, graphics, logos, links, and so on.
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When you open the Products section in the Content Editor, it looks like this:

== % -]

= & Content
) Home
& @rsample
i) Standard-Ttems
= @ products
B & Home-Products
@ cool-o-matic
3 wash-o-matic
& Office Products
& vacation-Products
& services
‘@ References
& Mews
83] People
(8 J0bs
|23 Contact
& About-Us
@) Help
) Meta-Data
i) settings

Content Editor

=M

@ Products 2a

/&y You must lock this item before you can edit it.
To lock this item, dick Edit on the Home tab.

® Lockand Edit

f Banner =]
Banner Slogan:
You want products?

We've got products!

Banner Image:

Dimensions: 720 x 130
Default Alternate Text: "Sparkles™

== Breadcrumb =2

Breadcrumb Title:

@ sitecore

As you can see, it is presented as a list of fields that you can edit. Furthermore, the fields you are
presented with are only those that belong to the Products item itself. The Sitecore logo, the Home
Products item, and so on are all separate items and must be edited independently of each other in the

Content Editor.
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51.2 The Content Tree

One of the main features of the Content Editor is the content tree that it uses to present all the items that
have been created for the Web site.

|._ Q@ -
= & Content
= ) Home
@ my prods
=l @& My Section
&3 My Item
& JJ Standard-Ttems
=) \'ﬂsample
) Standard-Items
= @ Products
£l 5 Services
# '\ References
H @ News
# |A| People
= (@ Jobs
# 3 contact
# g About-Us
@) Help
5 ) MetaData
£] Jj Settings

The Sitecore content tree has a similar tree structure to the one used in Windows Explorer. In Sitecore
objects and groups are not represented by standard folder and file icons but by many different icons. You
can expand and open every group in the Sitecore content tree just as you can the folders in Windows
Explorer. When there is a plus '+’ beside an icon, it contains sub items and can be expanded. When there
is a minus ‘-’ beside an icon, it has already been expanded and when there is no symbol, the item
contains no sub items.

Searching in the Content Tree

There is a search function associated with the Sitecore content tree. This helps you find items quickly and
can be particularly useful in very large Web sites and in sites that you are unfamiliar with.

To search for an object:

1. Inthe Content Tree, select the object that you want to search from. This is the starting point for
your search.

The Sitecore search engine searches the entire content tree. However, the search results list the
items that are found after this starting point above the items that are found before this starting
point.

The Sitecore search engine does not support wildcards.
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2. Inthe Search field, enter the value that you want to search for. This can be any character,
number, word, and so on.

[matic @ -]
&[5 sitecore
= & Content
) Home
@ sample
@ Help
i) Meta-Data
i) Settings
B Layout
= [&) Media Library
i) Files
i) Images
9 System
[E] Templates

3. Click the Search button Q or press ENTER to perform the search and the results are displayed.

[matic Q, ~]
(2, Search Results (Wash-o-matic) %
Subitems 1@ Wash-o-matic

Starting point for the search

Images § Cool o matic
\* Wash o matic

Content 1@ Cool-0-matic

Folder the item is stored in

Adding an Extra Criteria
Sometimes you might need to refine your search by entering extra criteria.
To add extra criteria to your search:

1. Click the drop-down arrow ™ to open an extra pane:

‘% Search Result X

2. If you want to search for an object by its name, enter the value in the Name field.
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3. To change the field that you search in, click the name of the field and a list appears displaying the
names of all the fields in the current item.

| matic

Name:

|

- Breadarumb Title
@ ad
', Seal

St

Description

<[]

Image
Menu Title

Menu Tooltip

Name

Number

Overview Abstract
Overview Image Max Width
Price

Related Items

Sidebar Text

Sidebar Title

Text

Title

Remaove

4. To add an extra criterion, in the Add Criteria field, enter the name of the criteria.

[matic Q ]
T

= (5] sitecore
= & Content
# ) Home
1| @ sample
H @) Help
# () Meta-Data
() settings
2 B Layout
=l (&) Media Library
) Files
= ) images
= ) Banners
- confused

wne crowd

5. Click Add Criteria to add the new criterion to the list.
You can then click the name of the new criteria and select a field name from the list that appears.

The results of the search are displayed in the Search Results pane. The items that were found
below the current item are displayed first.

Removing the Extra Criteria

To remove the extra criterion, click the criterion you want to remove and then click Remove at the bottom
of the menu that appears.

5.1.3 Locking in the Content Editor

In the Content Editor, you must lock an item before you can edit it.
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Locking an Item

To lock an item:

1.
2.

In the Content Editor, navigate to the item that you want to edit.

On the Home tab, click Edit to lock the item.

3. When you lock the item, the functions and commands that are available to you are activated in

4,

the Content pane.

[aCDnlEnl »vgv
A

{Ei Products

4f Banner =
af

Spellcheck
Banner Slogan:
You want preducts?

We've got products!

Browse * Properties * Open Media Library - EditImage * Clear - Refresh
Banner Image:

J/Images/Banners/sparkles

Dimensions: 720 x 130
Default Alternate Text: "Sparkles™

=8 Breadcrumb
[ Menu
|5) Page Title and Text =]

Title:

Products

Show Editor + Suggest Fix * Edit Himl

Text:

If vour organization sells products, create a Product Section to showcase them.

This demonstration section shows how vou can organize your products into Product
Catacaciac

You can now start editing the item.

Unlocking an Item

When you have finished editing the item, you must remember not only to save the changes but also to
unlock the item so that others users can edit it.

To unlock the current item, click Edit.

As a content author, you often have to make extensive changes to many items on the Web site. This can
mean that you have to lock many items and keep them locked to ensure that your changes are
implemented consistently across all the items.
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Sitecore keeps track of all the items that are locked to ensure that nobody else can edit them but it also
keeps track of all the items that have been locked by each individual user.

To unlock the items you have locked:

1. Inthe Content Editor, click the Review tab.

2. Inthe Locks group, click My items:

My Ttems
Wiews the items that are locked by you.

Products
News

sitecore /content/Home Products

Jeitecore fcontentHome News

Home [sitecore fcontent/Home:

Product Category Jsitecore /content/Home /Products/Product Category
Product Description [sitecore fcontent/Home Products /Product Description

Page 1of 1 (5items)

.
'

Close

The My Items dialog box lists all of the items you have locked. You can have locked these items
during the current session or during previous sessions.

Select the items that you are finished editing and click Unlock to unlock them or click Unlock All to
unlock all the items.
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5.2 Editing an Item in the Content Editor

As mentioned earlier, experienced content authors feel more at home with the advanced functionality that
is available in the Sitecore Content Editor.

Note
You must lock an item before you can edit it in the Content Editor.

In all the procedures and tasks described in this chapter, it is assumed that you have already locked the
item.

5.2.1  Working with Text
After you have selected an item in the content tree, you can edit it.
To edit an item in the Content Editor:

1. Inthe Content Editor, locate the item that you want to edit in the content tree.

[G@nlenl o517}
- ~
@ Products =
4P Banner =
Spellchack
Banner Slogan:

You want products?

We've got products!

Browse ° Properties * Open Media Library - EditImage - Clear - Refresh
Banner Image:
J/Images/Banners/sparkles

NV

4
——
-
i -

Dimensions: 720 x 130

Default Alternate Text: "Sparkles™
=8 Breadcrumb
[ Menu
|5) Page Title and Text =]

Title:
Products

Show Editor - Suggest Fix - Edit Himl
Text:
If vour organization sells products, create a Product Section to showcase them.

This demonstration section shows how vou can organize your products into Product
Catanadac bt

2. Inthe Content pane, locate the field that you want to edit.
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3. If you want to edit a single line or multiple line text field, you can do it directly in the field:

W Content T ——— s Y k-5
g@ Products —IC
«f Banner =
Spelicheck
Banner Slogan:

You want products?

We've got products!

Browse - Properties - Open Media Library - EditImage - Clear - Refresh
Banner Image:

/Images/Banners/sparkles

NV

4. When you want to edit a rich text field, you cannot edit it directly in the field:

[@ content : w-E-] )
Default Alternate Text: ‘Sparkles ~la
=8 Breadcrumb
[ Menu
Page Title and Text =]
Title:
Products

Show Editor [+ Suggest Fix * Edit Himl
Text:
vour organization sells products, create a Product Section to showcase them.

This demonstration section shows how you can organize vour products into Product
Categories.

5. Click Show Editor to open the Rich Text Editor:

2 Sitecore -- Webpage Dialog,
L N NP GARCR - J, E CRET:

If your organization sells products, create a Product Section to showcase them.

This demonstration section shows how you can organize your products into Product Categories.

|5) Design||= JHTML Accept Reject

The Rich Text Editor gives you access to more functionality. You can:
e Insert and delete links to other parts of the Web site and to external Web sites.
e Insert pictures or other media items.

e Insert symbols into the text
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e Paste text from Microsoft Word into the item.

If you prefer, you can use Microsoft Word to write the text you want to use in the item and
paste it into the Rich Text Editor.

¢ Find and replace text in the item.
Note

The functionality that is available in the Rich Text Editor is controlled by your Sitecore system
administrator. If you need more functionality, ask your administrator to make it available to you.

Furthermore, you can also view the item in HTML format, if you have the necessary expertise and
feel comfortable editing the text in that format.

6. When you are finished editing the item in the Rich Text Editor, click Accept to save the changes
you have made to the field.

7. Inthe Content Editor, scroll down through the item and expand all of the bands and check that
all of the fields contain the right content. For example does the sidebar contain the appropriate

text?
| @ Content - [0 1
[d sidebar e

Sidebar Title:
Product Awards

Show Editor |+ Suggest Fix * Edit Himl

Sidebar Text:

You've got the best products on the market.

You know it and the experts know it.

In fact. your products have won numerous awards.

But do vour visitors know it?

Tell them about it here, in the sidebar.

8. Click the Review tab and in the Proofing group, click Spelling to start the spell checker. The spell
checker runs through all the text fields in the item.

9. When you have finished editing the item, click Save to save the changes you have made to the
item and then click Edit to unlock the item so that other users can edit it if they need to.

Note
The spell checker only checks the current item. If you have edited several items, you must open them
individually and run the spell checker.

For more information about using the Rich Text Editor, see Chapter 6 ‘The Rich Text Editor.’

5.2.2  Working with Graphics

As a content editor, you will often have to change or edit the media items that are displayed on your Web
site.
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Changing an Image
To change an image:
1. Inthe Content Editor, locate the item that you want to edit in the content tree.

[aContant “val
{Ei Products = e
f Banner =
Spellcheck
Banner Slogan:

You want products?

We've got products!

Browse |- Properties - Open Media Library - EditImage - Clear - Refresh
Banner Image:
/Images/Banners/sparkles

S\V 7

Dimensions: 720 x 180
Default Alternate Text: “Sparkles™

2. Inthe Content pane, click Browse to open the Media Browser dialog box:

2 Sitecore -- Webpage Dialog, E]
= Media Browser
| Select the image or file that you want to open.

B [ & Media Library L
i Files
&} Images
& ) Barners
« confused
weese CrOWG
= friends

« hello W -
+ numbers -y
= OnEn Space - —

= rolled blueprints
= signpast.

mam sitecore key

) sit=core_fiashbann

e sparkles
=m spiral stairs
s team meeting b
< | >
Name: ‘P’Imageafﬂannersi’sparkles ‘

When the Media Browser opens, it displays the image that is already shown in the item you are
editing.

3. Locate the image that you want to use, select it and click OK.
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4. The image you selected is now used in the item you are editing.

W content [ d-=)d 1“’
@ Products = e
&f Banner =
Spelicheck
Banner Slogan:

You want products?

We've got products!

Browse - Properties * Open Media Library -| Edit Image - Clear - Refresh
Banner Image:
/Images/Banners/rolled blueprints

]

Dimensions: 720 x 180
Default Alternate Text: “rolled blueprints™

Uploading an Image

If the image you want to use is not available in the Media Library, you can easily make it available by
uploading it to the Media Library.

To add an image to the Media Library:
1. Inthe Content pane, click Browse to open the Media Browser dialog box.
2. Inthe Media Browser dialog box, click Upload:

A sitecore - Webpage Dialog,

Upload a File
Select a file. When done dick the Upload button.

Filename:

| M Browse 3|

Cancel

3. Inthe Upload a File dialog box, click Browse and navigate to the image that you want to add to
the Media Library.

The image is automatically uploaded to the Media Library and you can now use it on your Web
site.

Editing the Properties of an Image

After you have added an image to an item in the Content Editor, you can edit the properties of the image.
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To edit the properties of the image:

1. Inthe Content pane, scroll to the field containing the image.

@ content R——— - e k-3
&l @

5@ Products.

of Banner =]
of

Spellcheck
Banner Slogan:
You want preducts?

We've got products!

Browse ° Properties * Open Media Library - EditImage * Clear - Refresh
Banner Image:
/Images/Banners/rolled blueprints

Dimensions: 720 x 180
Default Alternate Text: "rolled blueprints™

A sitecore -- Webpage Dialog,
= Image Properties
WSl et the properties for the image here.
Text
Alternate Text: “

Default Alternate Text: Confused?

Dimensions

Enter the dimensions of the image if they are different than the dimensions of
the original. This will only affect the reference and not the original image.

Original Dimensions: 300 x 400

Space
Please provide the desired space to place around the image.

3. Inthe Alternate Text field, enter the text that you want to be displayed when you move the
mouse over the image.

4. Inthe Dimensions section, specify the dimensions that the image should be displayed in — if
they differ from the actual size of the image.

5. Inthe Space section, specify how much space should be placed around the image.

Editing an Image

You can also use Sitecore to edit the image if you need to.
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To edit an image:

1. Scroll to the field that contains the image.

m\—/gvgv E‘
@ Products 2@
J'Banner =

Spelicheck
Banner Slogan:
You want products?

We've got products!

Browse - Properties * Open Media Library | EditImage - Clear * Refresh

Banner Image:

/Images/Banners/rolled blueprints
m

\

3. Inthe Image Editor, you can crop, resize, flip and rotate the image.

If you need to do more to the image, you should use a proper image editor such as Photoshop or
Paint Shop Pro and then upload the image to the Media Library again.

4. When you are finished editing the image, click Save and close the Image Editor to return to the
Content Editor.

All the changes that you make are applied to the version of the image that is stored in the Media
Library and not just the copy shown on your Web page.

In the Content Editor, click Refresh to see the changes that you made.

6. If you want to remove the image, click Clear.
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5.3 Creating New Items in the Content Editor
There are several ways to create new items in the Content Editor.
You can:

e Create a new item

o Duplicate an existing item

e Copy an item to another location.

e Create an item based on a template.

In the Content Editor, when you insert a new item, it is generally created as a sub item of the current item.
However, you can also create a new item at the same level as the current item. You cannot create an
item that is at a higher level than the current item.

The following sections describe how to use the Sitecore ribbon to create, copy, move, duplicate and
delete items. You can also access all of this functionality by right-clicking in the content tree.

Navigate ~ Review  Publsh  Versions  Config

B Product Category o
ﬁ Product Description = || Duplicate |E
Q, | @ Content
=] v
B simeore Products
& & Content
@ Home D Quick Info
() standard-Ttems
(3 a Ttem ID:  {D7D)
Insert ¥ & | Product Category
ame: Produl
4o cut @ Product Description B
ath:  feitec
BB copy [ tnsert from Template )
q B reste late: fsitect
Eh : Created From: [unkn:
Duplicate
‘lJ B Ttem Owner:  [unkn|
U x Delete
B o T Rerame & sanner
&S] Me Copying  » Banner Slogan:
sy Sorting b You want pro
B 1e
@ Refresh We'we got pr

5.3.1 Creating a New Item

You can easily create a new item as a subitem of the current item.

Inserting a Sub-ltem

To insert a new sub-item:
1. Inthe Content Editor, locate the item for which you want to create a new sub-item.
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2.

3.

6.

In the Insert group, click one of the item types that is displayed:

Navigate Review Publish

‘:S 3 LN "‘ GContent

& [ sitecore i Produl
= @ Content
o 2”““’3 © quick Info
= @ Sample
. Ba
# ) Standard-Items pfiamory
= @ products Banner Slogz

& Home-Products You want
# F Office-Products

1 & vacation-Products
® [ Services

We've got

If the item type you want to insert is not displayed, click the scroll arrows in the Insert group to
find the type of item you want.

Alternatively, in the Insert group, click the drop-down arrow ™ and select the subitem from the
list that appears:

Insert a Mew Subitem.
& Product Cateaory
'@ Product Description

Insert a New Sibling.
e Site Section

D Insert from Template

In this drop down list, you can select a subitem or a sibling. A sibling is an item on the same level
as the current item.

To insert an item at the same level as the current item, in the Insert a New Sibling section, click
Site Section

In this example, we add a new product category to the list. This new category is a subitem of
Products and can contain its own subitems.

Select the type of subitem that you want to create and a dialog box appears prompting you to
name the new item:

A sitecore -- Webpage Dialog,

Enter the name of the new item:

|Nnve|ty Products

Enter a name for the new item.
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The new item is now added to your Web site.

O Navigate i My Toolbar

e @ content
= & ot Novelty Products
= ) Home
- @ samle @8 Breadcrumb
& () Standard-Items
&5 & @ Products Breadcrumb Title:
& & Home-Products MNovelty Products
) & Novelty Products
&
& Office-Products B [
o & Vacation-Products
B 8 Services Menu Title:
H § References MNovelty Products

As you can see, the new item has been created as a subitem of products and has been
automatically locked.

Every new item that you create is automatically locked and opened for you. You must unlock
them before other users are allowed to edit them.

7. Edit the new item. Scroll down through the fields and add an image, text, and so on.

When you have finished editing the item, you can add a new subitem to it.

5.3.2  Duplicating an Existing Item
Sitecore lets you duplicate existing items.
To duplicate an existing item:
1. Inthe content tree, locate the item that you want to duplicate.

In this example, we will duplicate the Wash-o-matic product and then move it to the new product
category that we just created.

2. Onthe Home tab, in the Operations group, click Duplicate and a dialog box appears prompting
you to name the new item.

3. Enter a name for the new item and it is added to the content tree:

My Toolbar

= -
& o The Hand Buzzer
#5) Home
" @ samle @B Breadcrumb
{J standard-ltems
& E @ Products Breadcrumb Title:
= a Home-Products Wash-o-matic
B Cool-o-matic
b @ The Hand Buzzer Cp [
@ Wash-o-matic
& 8 Novelty Products Menu Title:
& office-Products Wash-o-matic

As you can see, the new item has been added at the same level as the item you duplicated. It
also contains all of the same text, images, and so on as the original item.
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@ sitecore

4. Edit the new item and enter the text, images, and so on that you want to be displayed in this item.

When you have finished editing the item, you can move it to the correct location.

Moving an Item

To move an item:

1. Inthe content tree, locate the item that you want to move.

2. Onthe Home tab, in the Operations group, click Move To.

3. Inthe Move Item To dialog box, select the location that you want to move the item to.

4. Click Move to move the item to the new location.

5.3.3

2 Sitecore - Webpage Dialog,
. Move Item To

& (5] sitecore
= & Content
3 Home
& @ sample
i) Standard-Ttems
= @ Products
= & Home-Products
ﬁ Cool-o-matic
{3 The Hand Buzzer
@ wash-o-matic
3 Novelty Products!
& Office-Products
& vacaton-Products
8 services
@ References
& News

LE# Select the location where you want to move the item to,

1>

|

Name: ‘f’sitecurefcunlenLFSamp\efF'rUducts.waehy Products

Move Cancel

My Toolbar

[Searen @, -]

= & content
#3) Home
= & sample
i) standard Items
& = @ Products
= & Home-Products
@ cool-o-matic
B Wash-o-matic
= & Novelty Products
1B The Hand Buzzer
& office-Products
& & vacaton-Products
@ ski-Goggles
@ Swim-Fins

-3

Copying an Item to another Location

‘Content
@ The Hand Buzzer

=3 Breadcrumb

Breadcrumb Title:
Hand Buzzer

] Menu

Menu Title:
Hand Buzzer

Menu Tooltip [standard value]:

You can also create a new item by copying an existing item to the location where you want the new item

to belong.

To copy an item to another location:
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1. Inthe content tree, locate the item that you want to copy.

2. Onthe Home tab, in the Operations group, click Move To.

& Sitecore - Webpage Dialog,
= Copy Item To

Select the location where you want to copy the item to.

B[] sitecore
= & content
) Home
= ) sample
i) standard-Items
B Products
£ services
@ References
# News
1] Peaple
(@ J0bs
23 contact
&& pbout-Us
@) Help
) Meta-Data
i settings
(5] Media Library

Name: f’sltecurefcunlenl!Samp\e!F‘rUducts|

3. Inthe Copy Item To dialog box, select the location that you want to copy the item to.

4. Click Copy and the item is copied to the specified location.

= & Content
#3) Home
& & sample
) standard-Items
& & @ products
& & Home Products
B Cool-o-matic
@ wash-o-matic
& B Novelty Products
9 The Hand Buzzer
{3 wash-o-matic
& Office Products
& & vacation-Products
@ skiGoggles
@ swim Fins

-0

5. Edit the new item.

6. Onthe Home tab, in the Rename group, click Rename:

A Sitecore - Webpage Dialog

Enter a new name for the item:

@8 Breadcrumb

Breadcrumb Title:
Wash-o-matic

EMenu

Menu Title:
Wash-o-matic

Menu Tooltip [standard

|Red Nose|
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7. Enter the new name of the item.

5.3.4 Creating an Item Based on a Template

If you have been given sufficient access rights, you can also create an item based on a template.
To create an item based on a template:

1. Inthe content tree, locate the item that you want to create a subitem for.

2. Onthe Home tab, in the Insert group click the scroll arrow '™ and select Insert from Template.

2 Sitecore - Webpage Dialog, @
Insert from Template
ois Select a template and enter a name for the new item.
& [E] Templates b/
& ) Common

& {2 sample
B ) starter Kit
& ] Content Templates
@ About Us Item
|2 contact Location
] Executive Profile
52 Group
(8 10b Description
& News Artide
.‘ Product Categary
ﬁ Product Description
" Reference
£ Service Description
.‘ Services Category
—% Simple Item
& ) Field Sections -

Template: plates/Product Description

Item Name; |

3. Inthe Insert from Template dialog box, select the template that you want to use to create the
new item.

4. Inthe Item Name field, enter a name for the new item.
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5. Click Insert and the item is added to the content tree.

e Home Pubi My Toolbar

% & content @ Clown Shoes
#5) Home
& Ehsample = Breadcrumb
i standard-Items
& & @ Froducts Breadcrumb Title:
= & Home-Products Clown Shoes
@ Cool-o-matic
@ wash-o-matic
& = & Novelty Products Dtrens
& 3 Clown Shoes Menu Title:
& B Red Nose Clown Shoes
& 13 The Hand Buzzer
& Office Products Menu Tooltip [stzndard value]:
= & vacation-Products
3 ski-Googles
1B swim Fins
8 Services [Z) Page Title and Text
@ References Title:
& News Clown Shoes
|| People
8 50bs Show Editor - Suggest Fix * Edit Himl
|23 contact d value]:
33 About-Us g vour foot in it?

6. Edit the item.

7. Save your changes.

Previewing Your Changes

When you have finished editing all the new items that you have created you might like to see how these
new items will look on your Web site.

To see a preview of your changes:
1. Click the Publish tab.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 57 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

2. Inthe Publish group, click Preview to see how the item looks.

» Sample » Products P MNoveltyProducts » ClownShoes | B Go

sitecore

compelling web experiences’

m Fe d et mn

Home » Products » Nowelty Products » Clown Shoes

Products Clown Shoes

Hieins Py Feel like putting your foot in it?

= Nowvelty Products Try our clown shoes - then you'll really lock the part!
Clown Shoes
Red Nose Price: §99.99
Hand Buzzer

[# Office Products

[# Vacation Products

A new browser window opens displaying the current item. You can then browse the Web site to
see all the changes that have been made.

The following changes have been made to the sample site:

e The Novelty Products category has been added to the product category list. The Products page
contains a Novelty Products entry.

e The novelty items, Clown Shoes, and so on, have been created in the novelty products category.
The Novelty Products page lists all of the products that we created items for.

o Each of the products that you created has its own page in the Web site.

When you are satisfied with all the changes that you have made, unlock all the items that have been
locked during this session.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 58 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

54 Deleting Items in the Content Editor

Content authors must delete items and content from time to time. This is a simple task in the Content
Editor.

5.4.1 Deleting an Item

To delete an item from the Web site:
1. Inthe content tree, locate the item that you want to delete.
2. Onthe Home tab, in the Operations group, click Delete.

Alternatively, you can right-click the item in the content tree and click Delete in the shortcut menu
that appears.

The item is deleted from the Web site.

3. If you try to delete an item that contains sub-items, a message will appear informing you that that
the section contains sub-items and that these items will be deleted along with the main item.

Windows Internet Explorer

N

#ire you sure you wank to delete "Movelty Products'?

This item has sub-items which will also be deleted if you delste this item,

If you want to save any of the items, you must move them to another part of the Web site.

4. Click OK to delete the item and its subitems.
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The Rich Text Editor

The Rich Text Editor is the word processing tool that Sitecore uses. This chapter explains
some of the functionality that it contains. The topics described in this chapter include
inserting, removing and managing links.

This chapter contains the following sections:

e Using the Rich Text Editor
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6.1 Using the Rich Text Editor

When you are editing a rich text field in the Page Editor or in the Content Editor, you must use the Rich
Text Editor. This is a standard word processing tool but in Sitecore we have removed most of the
formatting functionality because the format of the items that content authors create and edit is determined
by the style sheets and templates that have been implemented for your Web site.

However, if you need access to more functionality in the Rich Text Editor, you should contact your system
administrator and they can make it available to you.

6.1.1 Editing Text

When you open the Rich Text Editor, the text in the field you are editing is displayed:

A Sitecore - Webpage Dialog,

EIE T LG e T IEr s

When you click the O Edit this Site link, you are reguested to enter a username and a passwerd.
The starter kit includes some predefined users that demonstrate varicus levels of functienality.

Choose one of the following:

User PassDescription

Minnie | m User with minimal authoring features.
Lonnie | | User with imited authoring features.
Audrey: a User with normal authoring features.
Denny | d User with page designing features.
Admin @ b User with access to all features.

QDeslgn :_]HTML Accept ” Reject
—

You can now edit the text and use the functionality that is available.

Pasting Content from Word

As a content author, you might feel more comfortable writing your content in Word. When you are
satisfied with the material, you can paste it into the Rich Text Editor.

To paste content from Word:

1. Select and copy all the text in Word that you want to paste into a rich text field in Sitecore.
2. In Sitecore, open the Rich Text Editor.
3. Click the Paste from Word button L and the text is pasted into the Rich Text Editor.

When the text is pasted in all of the information about fonts, sizes, formatting, and so on is
removed.

However, if you have created a table in Word, it is pasted in and you must reformat it in the Rich
Text Editor.

6.1.2 Inserting, Removing, and Managing Links

As a content author, you will have to manage links in your content. The Rich Text Editor allows you to
insert, remove and edit the links in your content.
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Inserting an Internal Link
An internal link is a link to another item on your own Web site.

To add an internal link:
1. Inthe Rich Text Editor, select the image or text that you want to be a link.

2. Click the Insert Sitecore Link button ﬁ.

A Sitecore - Webpage Dialog, E]
Insert a Link
Select the item or media that you want to create a link to.

E {[] sitecore |
= ) Content
#3) Home
& sample
@) Help
) Meta-Data
) Settings
B Layout
&) Media Library
B3 System
EITamplatas

3. Inthe Insert a Link dialog box, in the Internal Link tab, expand the content tree and select the
item that you want to create a link to.

Click Link to create the link.
If the item you want to create a link to is an image or media file, click the Media Items tab.

2 Sitecore - Webpage Dialog,
Insert a Link
Select the item or media that you want to create a link to,

| Internal Link | Media Items |
= (&) Media Library
i Files

® ) Images

6. Expand the content tree and select the media item that you want to link to.

7. Click Link to create the link.

Inserting an External Link

An external link is a link to another Web site.
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To insert an external link:

@ Sitecore

1. Inthe Rich Text Editor, select the image or text that you want to be a link.

2. Click the Hyperlink Manager button r .

a Hyperlink Manager -- Webpage Dialog, @

@ Hyperink  [a Anchor s E-mail

URL: hitp:fivew w sitecore.net
Existing AnchorNone +
Link Text: Sitcore softwars

Type hitp -

Tooltip
CS5 Class:

Target Target

3. Inthe Hyperlink Manager dialog box, enter the information about the Web site you want to link

to.

Field Value

URL The URL of the Web site.

Existing Anchor Whether there is an anchor already.

Link Text The text in the link. You can edit this text here.

Type The type of link you want to create.

Target The window that the link should open.

Tooltip A tooltip that is displayed when you move the mouse over
the link.

CSS Class The style sheet that the link should use.

Managing Hyperlinks

You can also use the Hyperlink Manager dialog box to edit existing links, create anchors and create e-

mail links.

An anchor is an HTML code that is used to create a link to another page or to a particular section within a

page.
To create an anchor:

1. Inthe Rich Text Editor, select the image or text that you want to be an anchor.

2. Click the Hyperlink Manager button r .
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3. Inthe Hyperlink Manager dialog box, click the Anchor tab.

a Hyperlink Manager. -- Webpage Dialog

& byperink [ Anchor s E-mail

Name: My Anchor

4. Inthe Name field, enter the name of the anchor.

5. You can now create a link to this anchor by selecting it in the Hyperlink Manager dialog box.

a Hyperlink Manager -- Webpage Dialog,

@ Hyperlink [ Anchor  [xgs E-mail

URL: #My Anchor
Existing Anchor| My Anchor |+

ke

Target I | [Target v

o [ &

C55 Class: NoClass =+

You can also use the Hyperlink Manager to create e-mail links. An e-mail link opens a new mail in the
program you use to send e-mail, for example, Outlook. The e-mail will be sent to the e-mail address
specified in the e-mail link.

To create an e-mail link:

1. Inthe Rich Text Editor, select the image or text that you want to be the link.

2. Click the Hyperlink Manager button (& .
3. Inthe Hyperlink Manager dialog box, click the E-mail tab.

a Hyperlink Manager -- Webpage Dialog

@ Hyperink [ Anchor [ E-mail

Address: |mai\@5'rtacore.net |

Link Text:  |Contact us. |

II
=

Cancel

subject: || |

C55 Class: Mo Class

4. Inthe Address field, enter the e-mail address that the mail should be sent to.

5. Inthe Subject field, enter the text that you want to appear in the Subject field in the e-mail.
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Removing a Link

0,

To remove a link, in the Rich Text Editor, select the link and click the Remove Link button “== . The link is

removed and the text becomes ordinary text.

Note
You can use the Hyperlink Manager to edit any links that exist on your Web site.
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Workflows for Content Editors

This chapter describes workflows, what you can use them for, and how Sitecore uses
them. There is also a description of the Workbox.

e  Workflows

e The Workbox

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 66 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

7.1 Workflows

Workflows are a system that you can use in Sitecore to control when an item is published.

A workflow is a series of states that you define to reflect the work processes and procedures that you
employ in your organization for creating Web content. These states can correspond to the creation,
review, and approval stages that items must go through before they are published on your Web site.

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only
items that have been approved are published.

A workflow can contain any number of different workflow states and be as simple or complex as required.
Items do not necessarily have to pass through all the workflow states that you have defined — some
states can be optional or only applicable for certain kinds of content.

Furthermore, you can implement any number of different workflows. Each workflow must contain one
workflow state that has been defined as the final workflow state.

Items must pass through the appropriate workflow states and can only be published when they are in the
final workflow state.

7.1.1 Implementing Workflows

Workflows are normally implemented by developers. It can however be useful for content authors to
understand how they are constructed and implemented.

Workflows consist of special items that are stored in the Sitecore content tree.
A workflow consists of:
A Workflow — the main item that contains all of the subitems that make up the workflow.

Workflow States — the basic building blocks of the workflow. The workflow states represent the different
stages in your content creation process. Items that are sent through a workflow start in the initial workflow
state and in the final workflow state.

Workflow Commands — the actions that must be performed by the various contributors to move the
items from one workflow state to another.

Workflow Actions — actions that are automatically performed on the items when they are in particular
workflow states or when particular workflow commands are executed.

Here is an example of a workflow:

+

Workflow Items I
= & Workflows

T Workflow =t = T Sample Workflow , Workflow States

= [ editng <«——— Initial Workflow State

&) Submit

&) Command = [@ Reviewing
. !a Approve

&8 Action O Reject

= @ Publshed «———Final Workflow State

@ Auto Publish ~

(L) State
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After the workflow has been defined, the developer specifies which item templates are subject to the
workflow. When they have done this, every time a content author creates or edits an item that is based on
one of these templates it is sent to the initial workflow state of this workflow.

Important
Items can only be published when they are in the final workflow state.

7.1.2  Using Workflows

After the workflow has been implemented, content authors must send the items they create or edit
through the workflow before they can be published.

When you create a new item it is automatically placed in the initial workflow state. The item remains in
this state until you use a workflow command to move it to another workflow state.

If you edit an existing item that is subject to a workflow, Sitecore creates a new version of this item and
places it in the initial workflow state. If you edit this item again later, you edit the version that is in the
workflow unless you specifically that you want to edit another version.

Important
Items that are edited by administrators are not subject to workflows.

Sending Items through Workflows
When you have finished editing the item, you can send it to the next workflow state.
To send an item to the next workflow state:

6. Inthe Content Editor, open the item that you are working on.

7. When you are satisfied that it can be send on through the workflow, click the Review tab.

o Home Navigate Review Publish Versions My Toolbar

You have locked this item, | %® CheckIn (&) Submit . @
RN 3
speling Markup Validation || My Items 4P History Reminder ~  Archive +
t oofing Locks Wo Sched

| Q | acament\ B2 ]_

= & Content - Ala
8 G Home m Qur-Company

) standard Ttems

/&y If you publish now, the selected version will not be visible on the Web site because it is not in the

1@ Froducts final workflow step.
3 Services Version 1 wil be published instead.
‘@ References <f Banner a8
G New:
B @ News Banner Slogan:
] ] People Great Company!
| &3 Our-Company Great Products!

As you can see, the Workflow group displays a workflow command — Submit. This is the only
workflow command that you can apply to the current item in its present workflow state.

Furthermore, the item also displays a message informing you that this version of the item cannot
be published because it is not in the final workflow state.
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@ sitecore

Click Submit to send the item to the next workflow state. Sitecore displays a dialog box for you to

enter a comment

A sitecore -- Webpage Dialog

Enter a comment:

9. Enter a comment and then the item is moved to the next workflow state and the workflow
commands that are available in the Workflow group change to reflect the items new status.

Publish

Versions My Toolbar

Locks

‘ Click Edit to lock and edit this item,

[ Edit

Q Approve

§r History o Reject

]

= & Content
= ) Home
i) Standard-Ttems
@ Products
3 services
‘@ References
& News
LII Peaple
&3 Our-Company
) Metz-Data
) settings

' Content W

m Qur-Company

‘3 You must lock this item before you can edit it.

To lock this item, click Edit on the Home tab.
® Lock and Edit

& If you publish now, the selected version will not be visible on the Web site because it is not in the

final workflow step.
Version 1 will be published instead.

J Banner

Banner Slogan:

However, if you do not have permission to edit the item in this workflow state, you cannot lock the

item for editing and the workflow commands will not be displayed.

Sitecore also contains a Workbox that been designed for give reviewers a greater overview of all the

items that are

in workflows.
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7.2 The Workbox

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform
their tasks.

Using the Workbox

When you need to review content items, you should use the Workbox to see all the items that are
currently in workflows and which workflow states they are in.

To use the Workbox:
10. Log in to the Sitecore Desktop.
11. Click Sitecore, Workbox:

% Workbox

Sample Workflow

f Draft - (none)

l Awaiting Approval - (1 item)

Da Our-Company - [English, version 2}

hange: audrey changed from Draft to Awaiting Approval on 1. apri 2003, More »

B prrevien [@open oiff @ approve @ Reject

| @ Aporove (selected) @ Anprove () EDReject (selected) € Reject ()

In the Workbox, you can see that the Sample Workflow has been selected and you can see all
the relevant workflow states. You can also see that there is one item in the Awaiting Approval
workflow state.

12. In the every workflow state, you can preview, open, compare, each item as well as apply the
workflow commands that have been defined for that workflow state. In the Awaiting Approval
workflow state, you can approve, or reject the item.

Previewing an Iltem

To preview the version of an item that is in a workflow state, click Preview and this version of the item is
displayed in a new browser window.

Opening an Item

To open an item, click Open and the item is opened in the Content Editor.
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Comparing an Item

To see the changes that have been made to an item, click Diff.

2 Sitecore — Webpage Dialog
1oy Compare Versions
u Compare two version of the same item. The differences are highlighted.

One Column Two Columns.

E v

Qur Company

ooltip:

! page Title and Text =

Qur Company

Text:

What a company this is to work in! # We are an innovative
company that offers a unique range of products and services.

| Related Ttems @
Related Items:
| sidebar @

The Compare Versions dialog box lets you see the changes that have been made to this version of the
item. You can select which versions to compare and whether you want them displayed in one or two

columns

Approving or Rejecting an Item

When you are finished reviewing the item, click approve or reject to move the item to the appropriate

workflow state.
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Several Workflows

If you have implemented more than one workflow, you can view them at the same time or switch between
the different workflows in the Workbox.

[} Edit- mone)

Q Aweaiting Approval - (nene)

% Validation

(&} Edit- 1 item)
Awaiting Approval - (1 item)

Da Corporate info - (Enghsn, verson 2)
s2: minrus changad from Edit 1o Awaiting Approwalsn Thursday, July 03, 2008, Mors »

Brreven Booe Dot Daooe Qreea

| @ approe (seiected) @ Acprove (a1) @ Reect fseiected) @ Reject (ol)

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows group.
You can also expand and collapse each workflow and workflow state.
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Customizing the Interface

You can change the interface in Sitecore. This chapter describes how to increase usable
screen space, customize the interface in the Content Editor and in the Page Editor. There
is also a description of how to customize the Sitecore Desktop.
This chapter contains the following sections:

¢ Working with the Browser

e Customizing the Content Editor

e Customizing the Page Editor

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 73 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

8.1 Working with the Browser

All of the interfaces and programs that Sitecore contains are displayed in a normal Web browser.

8.1.1 Full Screen Mode

If you need to see more of the Web page or item that you are editing because there are too many
elements in the way or because you are using a computer with a small screen, you can gain some space
by expanding the browser interface to full screen mode.

To enable full screen mode, press F11. This expands the browser window to fill the entire screen and
hides the user interface elements of the browser — the title bar, menus, toolbar and status bar.

To see some of hidden user interface elements, move your mouse to the top of the screen. Press F11
again to restore the hidden browser user interface elements and exit full screen mode.

8.1.2 The Sitecore Desktop

When you are using the Sitecore Desktop application you can change some of the settings that affect the
way Sitecore looks and customize other settings to suit your needs.

In the Sitecore Desktop, you can:
e Change the desktop background.
e Change your password.
e Change the application options.
e Change your personal information.

e Change the language settings.

Changing the Desktop Background

You can change the image displayed as your desktop background when you log in to the Sitecore
desktop.

To change the desktop background:
1. Login to the Desktop.
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2. Click the Sitecore menu and then click Control Panel, Preferences:

El control Panel

[®] Preferences
<

Pick a task...

E| Change Your Desktop Background

E| Change Your Application Options

[3] change Your Password

[3] change Your Personal Information

E| Set Your Regional and Language Options

E| Reset My Settings to Default Yalues

3. Inthe Preferences dialog box, click Change Your Desktop Background.

A Sitecore - Webpage Dialog E3
pag g
Desktop Background
Select a desktop background.

Background:

{None) Position:
Blue
Building
Chameleon cape Color:

Keﬁboam

Pine neddles

Sparkle

Stairs

Sudak still rocky shore
Warking

In the Background field, select the image that you want to use.

In the Position field, use the drop down arrow to select how you want to place the image on the
desktop.

6. Inthe Color field, select the color you want to surround the image if it does not fill the screen.

Changing Your Password
To change your password:

1. Inthe Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences.
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2. Inthe Preferences dialog box, click Change Your Password.

A Sitecore -- Webpage Dialog,

Change Pasword

Enter your current and new password.

Password: I |

New Password: [ |

Confirm New Password: | |

Change Password | [ cancel |

3. Inthe Change Password dialog box, enter your current password and then enter and confirm
your new password.

You can also change your password in the Sitecore log in page.

Q sitecore’
Welcome to Sitecore

Login

Forgot Your Password?  Change Password

Changing your Personal Information
To change your personal information:

1. Inthe Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences.
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2. Inthe Preferences dialog box, click Change Your Personal Information.
A Sitecore - Webpage Dialog, E]
Personal Information
Change your personal information.
Full Name: |My Mew Name |
Email: |mynewema\l@address,net |
Portrait: g User1 A
User2
User3 b
Angel
Astrologer
Dudel
Dude2
Dude3 L
3.

In the Personal Information dialog box, you can change your name, e-mail address, and the
image that is used as your portrait throughout Sitecore.
Changing Your Regional and Language Options

To change your regional and language options:
1.

2.

In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences.
In the Preferences dialog box, click Set Your Regional and Language Options.

A Sitecore -- Webpage Dialog, @

Regional and Language Options
Change your regional settings to reflect your preferences.

Standard and Formats:
This option affects how numbers, currendies, dates and time are formatted.
Select an item to use its preferences.
©
Samples:

number:  [123,456,789.00

currency: [2123,456,789.00

Tme: [10:30

Short date: [06/13/2008

Long date: [Friday, 13 June 2008

Client Language
Select the language to use in the dient application.
English

3. Inthe Regional and Language Settings dialog box, you can:

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.

Page 77 of 88



Sitecore CMS 6 Content Author's Reference and Cookbook @ S|teco re

o Select the formats that you want to use for numbers, currencies, times, and dates.

o Select the language that you want the client application to use.

Using the Default Settings
To use the default settings:
1. Inthe Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences.

2. Inthe Preferences dialog box, click Reset My Settings to Default values.
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8.2 Customizing the Content Editor

The Content Editor contains a variety of user interface elements that you can customize to suit your
needs.

You can, for example, give yourself more room to work in by:
e Customizing the ribbon.
e Customizing the content tree.

e Resizing the editing pane.

8.2.1 Customizing the Ribbon
There are several ways in which you can customize the ribbon.
You can:

e Hide the ribbon.

e Hide the tabs.

e Create your own toolbar

Hiding the Ribbon
To hide the ribbon in the Content Editor:
1. Double-click any tab to hide the ribbon.

O Home Navigate Review Publish Versions Configure Presentation View Developer
Search @, ~ |[| @ content 8- [ ]
=] ite L
[ sitecore [ sidebar oL
B & Content

The ribbon is removed but the tabs are still displayed.

2. Click on atab to open that tab and display the ribbon again.

Hiding Tabs
You can also specify which tabs are displayed in the Content Editor.
To hide a tab:
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1. Right-click anywhere on the ribbon to open a dialog box:

Home
Navigate
Review
Publish
Versions
Canfigure
Presentation
Security
Wiew

My Toolbar

Developer

Reset

Customize

@ Sitecore

2. Select or clear the check boxes to decide which tabs you want displayed in Content Editor.

3. Click reset to restore the default tab selection.

Creating your own Toolbar

You can also create your own toolbar that only contains the tools and functionality that you need to do

your work.

To create your own toolbar:

1. Right-click anywhere on the ribbon and click Customize to open the Customize My Toolbar dialog
box.

A sitecore -- Webpage Dialog,
@ Customize My Toolbar

Add or remove commands from My Toolbar,

Al

Selected

DAppearance

[E) Attributes

D Clipboard

[E] Close Preview

D Create

D Fields

[2) Goto

D Insert

D Insert Options

= Language

D Layout

[2) Layout Presets

[2) Locks

D My Strip

[2) Navigate

D Qperations

[=) ownership
|

& )

k3

o
(€]

13

Customize

Ge

|

1. Inthe All pane, expand the groups and select the commands that you want on your toolbar.
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You can only select commands and not groups. You can however insert separators to divide
them into groups and use the up and down arrows to place the commands in the order you want.

A sitecore - Webpage Dialog,
= Customize My Toolbar
ﬁ Add or remove c‘u’mmands from My Toolbar.
All Selected
E T My Strp ~ @ [Customize (1]
[2) Navigate (| Separator (4]
[£] operations Paste
) ownership Copy
D Page Urls gz&aramr
[ Preview Renama
Bl Proofing
[ Publish Spellcheck
[£) Publish Restrict
a D Rename
D Rename
2] Display Name
D Schedule
D Search
[ security
D Security Preset
D Security Tools
= Separator
[ serialize
e s = Separator |

2. When you are finished, click OK.

3. Right-click on the ribbon to open the tabs dialog box and select the My Toolbar tab. The tab is
added to the ribbon and contains all the command that you just selected.

O Home Navigate Review Publish Versions Configure Presentation Security View My Toolbar Developer
About Us Section

2] Contact Section

8.2.2 Customizing the Content Tree
In the Content Editor, you can easily resize the content tree pane or hide the content tree entirely if you
prefer.
Hiding the Content Tree
To hide the content tree:
1. Inthe Content Editor, click the View tab.

o Home  Navigate  Rev Publish Versions  Configure  Presentation  Security

2. Clear the Content Tree check box to hide the content tree.

3. Clear the Entire Tree check box to hide the root of the content tree (sitecore) and the media
library. This view ensures that users can only see the items that are part of their Web site.
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4. Clear the Hidden Items check box to hide some of the system items that are displayed in the
content tree.

The other two settings — Raw Values and Standard Fields are only relevant for administrators.

Resizing the Content Tree

You can also resize the content tree. This can be useful when you need to find an item or when the pane
takes up too much space.

To resize the content tree:

1. Inthe Content Editor, move the mouse over the bar between the Content Tree and the Editing
pane.

2. Drag the bar to the left or right to resize the elements in the window.

Configuring the Quick Action Bar

The Quick Action Bar runs down the side of the content tree and can be used to display information that
can be useful to both the content author and the administrator.

= [ sitecore

&

# ) Home

Quick Action Bar

To configure the Quick Action Bar

1. Right-click the Quick Action Bar to see a list of the elements that it can display.

My Locked Items
Locked Ttems
Workflow State
Broken Links
Missing Versions
Publishing Warnings

Validation Rules

@ Refresh

2. Click an item in the menu to hide or display an icon beside the item that is affected.

You can select the following items:

Menu Item Tells you

My Locked Items Which items you have locked.

Locked Items Which items have been locked by another user and
who locked it.
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Menu Item

@ Sitecore

Tells you

Workflow State

The workflow state of the item.

Broken Links

Which items contains broken links.

Missing Versions

Which items are missing a version.

Published Warnings

Which items have published warnings

Validation Rules

Which items contain validation errors.

Note
The items that are available in this menu in your Sitecore solution may vary from the ones shown here.
This is controlled by your Sitecore system administrator.

You can select as many of these options as you like. There is a performance overhead to pay for each of
these options.

Important
The Validation Rules and Broken Links options are the most costly of the Quick Action Bar options. Each
time you open an item in the content tree the client must make a server call to refresh these options.

8.2.3 Changing the Application Options

When you are using the Content Editor, you can also specify which elements of the Content Editor
application should be displayed.

To configure the Content Editor:
1. Inthe Content Editor, click on the Sitecore button in the top left-hand corner.

Properties
Application Options
‘ Licenses

i) About

Exit

Alternatively, in the Sitecore Desktop, click the Sitecore menu and then click Control Panel,
Preferences.
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2. Click Application Options to open the Application Options dialog box.

A Sitecore -- Webpage Dialog,
Application Options
Change your options.
Content Editor | view |
Show Hide

Ttem Title Bar

Field Section Titles

Fields from the Standard Template
Hidden [tems

Quick Info Section

Quick Action Bar

Seach Panel

validator Bar

Use Smart Tags

Prefetch Collapsed Sections
Field Values

® show Input Controls

O show Raw Values

Pages
Show Pages Bar

3. Select or clear any of the check boxes to hide or show the element in question.

The following screenshot points out where most of these elements are found in the Content Editor:

Search Panel

Item Title Bar

! (SEFI0TFTCOIAACESAF 11 EF BAZIAFET)

Quick Info Section

Tnem Path:  fgnecore fcontentiome
Templote! jtecore Samplates Starter K2 1oem Types Ste Roct - (SACEOAED-JLAF400E 310

Hidden Items =

Crested From: (urknown]
Them Ownert [urimoe)

& Banner .
& Breadcrumb

Quick Action Bar — Svericrumb TR

Home

Wl »

Drvena .
[ Ravrgation .

|2 Page Title wnd Text

Tithe:

Field Section Titles

Validator Bar

The remaining elements in the Show/Hide section are:

e Fields from Standard Template — selecting this option will display a large number of fields that
are used internally by Sitecore. These are hidden to improve performance.
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e Use Smart Tags — an alternate way to show the commands associated with a field.

Show Editor * Suggest Fix - Edit Himl
 Show Editor ~
‘What do you  Show Editor |7

Suggest Fix
Edit Himl

e Prefetch Collapsed Sections — the system fetches and keeps the fields from the Field Sections in
memory before the section is even opened.

The other important option on the Content Editor tab is in the Pages section — Show Pages Bar.

This option determines whether or not the shortcuts to the Sitecore applications are displayed at the
bottom of the screen.
| Combant-Cartar—iRTRt Library Workbox

O sitecore”

Pages Bar

++ Content Editor

The View tab of the Application Options dialog box contains a few more options.

A sitecore - Webpage Dialog,

Application Options
Change your options.

Content Editor | View

Content Tree - [tem Names

® Display Mame (Janguage-specific name)

O Item key

Content Tree Root

Show the Content Tree in the Content Editor

Show Entire Content Tree

In the Content Tree — Item Names section, you can specify whether you want the content tree to show
the key that each item has or to show the language specific display name that you can give an item.

In the Content Tree Root section, you can specify whether or not you want the content tree shown in the
Content Editor and whether or not you want the entire content tree shown.

Setting the Display Name of an Item
To set the display name of an item:

1. Inthe Content Editor, select the item in the content tree.
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On the Home tab, in the Rename section, click Display Name.
When you are prompted, enter the name that you want displayed in the dialog box that appears.

Refresh the content tree and the display name is visible:

& Product Category I‘ (HiCopyTo§ .., o Rename = —
i
Save @ Product Description Duplicate @M@ve To pelete - || Paste @ Copy T Display Name
e Operations Clipboard Rename L
[searct 9, =] [ W content
EHEE .
(2] sitecore My Display Name - [novelty ltems]
= & Content
[+
# ) Home D quick Info
= @sample
) standard-Items Ttem D¢ {EFSFFSGE-147B-4EAF-ASFC-FEGSED 723237}
= @ Products Ttem Name: novelty Ttems - Display Name: My Display Name
& Home-Froducts Item Path: fsitecore fcontent/Sample/Products/novelty Ttems
& My Display Name
2 Hovelty Items Template: /sitecore /templates/Starter Kit/Content Templates/Product Category - {8A471A2CF885-416F-826E-5CD3
& Office Products Created From: [unknown]

@ sitecore

In the Content pane, the key is shown after the display name.

Furthermore, the display name is also used for the item in the published Web site.
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8.3 Customizing the Page Editor

You can also customize the Page Editor. However, because the Page Editor contains limited functionality
there is not that much that you can change about it.

8.3.1  Working with the Ribbon

The functionality that is available to you in the Page Editor is determined by the roles that your site
administrator has assigned you.

Hiding the Ribbon

If you only have limited access to the functionality contained in the Page Editor, you can hide the ribbon
to give yourself more space to work with.

To hide the ribbon:
1. Login to the Page Editor.

Save Save & Clozse Close Ribbon

Page Editor | Preview || Insert Delete Lock My Items (0) Warkbox || Log OFF

| Ed
» Home » | S Go (B Edit

YourSite.net

2. Click the Ribbon button at the top of the screen to hide the ribbon.

3. When you need to use the ribbon, click Ribbon and it appears again.

Changing the Interface

If you have access to more functionality in the Page Editor, you can also change the way the Page Editor
presents editable items to you.

To change the interface:

1. Login to the Page Editor.

Save Save & Close Clase Ribban

Page Editor Home Wersions View

B De

Page Editor | Preview || Insert Delete Lock My Items (0) Workbox || Log OFf

» Home » | ©pGo [ Edit

YourSite.net
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2. Inthe Page Editor, click the View tab.

Save Save & Close Close Ribbon

Page Editor Home Versions View
Editable [ ] pots
Floating Frame

| Show/H

b Home b | & Go [ Edt

H
. YourSite.net

3. Inthe View tab, select or clear the check boxes to:
o Specify whether or not the items are editable.
o Whether or not the editable items are displayed in a floating frame.

o Whether or not a dot is displayed beside the editable items.
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